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Abstract

Sea urchin gametes have been historically used to demonstrate fertilization and early development 

in student laboratories. Large amounts of egg and sperm are easily acquired, and the conspicuous 

changes in egg surface morphology, indicative of sperm-egg fusion and egg activation, are readily 

observed in the classroom. However, less often incorporated into teaching labs are exercises that 

demonstrate the dramatic metabolic changes that accompany egg activation. One example is the 

massive up-regulation of various essential transport activities in the embryo’s plasma membrane, 

including xenobiotic transporter activity. Here we outline a laboratory that incorporates this 

concept into a teaching lab, capitalizing on the magnitude and uniformity of the xenobiotic 

transporter activation event in certain species of sea urchins. The introduction of this chapter 

provides background information for the instructor, and the remainder serves as a laboratory 

manual for students. The experiments detailed within the manual can be completed in a total of 4–

8h spread over one or two lab periods. The lab manual guides students through a modified version 

of the United States Environmental Protection Agency (EPA) toxicity test, a novel undergraduate-

level laboratory on xenobiotic transporters, and analysis of microscope data using ImageJ. We 

have found this lab to be of interest to a wide range of biology and environmental science 

undergraduates, and effective in teaching underlying concepts in developmental biology, 

physiology and toxicology.

1 Corresponding author: lshipp@ucsd.edu. 
1.Start the STATPLUS program. Excel should open.
2.Click on the StatPlus icon. Go to STATISTICS > BASIC STATISTICS AND TABLES > DESCRIPTIVE STATISTICS. A 
Descriptive Statistics window will display. Place the cursor in the Variables Box.
3.Return to the Excel worksheet and select the cells containing the data. Return to the Descriptive Statistics window, where the cells 
and worksheet will be referenced in the Variables Box.
4.Find the “Labels in First Row” option in the lower left corner of the Descriptive Statistics window and determine whether the box is 
checked. If the first row selected contains data, uncheck the box or else those data will not be included in the calculation.
5.Click OK. Allow StatPlus is performing the analysis without returning to Excel.A new worksheet will open showing the descriptive 
statistics once StatPlus has finished. Copy and paste the results into the worksheet with the data.
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1 INTRODUCTION

The sea urchin has long been used to teach university and high-school students about 

fertilization and early development. Sea urchins are exceptional teaching tools in 

developmental and cell biology for several reasons. Their gametes are easily and 

inexpensively obtained in large quantities, eggs and embryos are of sufficient size and clarity 

to be viewed under any standard light microscope, early development is synchronous, and 

different species of sea urchins are available worldwide and have broad reproductive periods 

(Pearse & Cameron, 1991). For decades, sea urchin fertilization has been a favorite 

classroom activity because it occurs externally in seawater and can be observed in real-time 

by monitoring the formation of the fertilization envelope (FE).

In all known organisms, the fusion of egg and sperm results in massive structural and 

functional reorganization of the egg plasma membrane. In sea urchins, the structural changes 

include the fusion and release of egg cortical granules to create the FE within seconds-to-

minutes of sperm and egg fusion. Subsequent waves of exocytic events lead to deposition 

and formation of a complex network of extracellular matrix molecules (Matese, Black, & 

McClay, 1997). The functional changes include a dramatic modification of egg plasma 

membrane (PM) selectivity toward ions and small molecules, such as nucleosides 

(Piatigorsky & Whiteley, 1965), phosphate (Whiteley & Chambers, 1966), amino acids 

(Epel, 1972), and xenobiotics (Hamdoun, Cherr, Roepke, & Epel, 2004). This is mediated by 

the insertion of various transporters into the PM following sperm and egg fusion (Epel, 

1975).

Previous protocols have taken advantage of the sea urchin to introduce students to the 

structural events that accompany fertilization (Epel, Vacquier, Peeler, Miller, & Patton, 2004; 

Vacquier, 2011). Here we build upon these by providing a lab exercise that demonstrates the 

physiological consequences of membrane restructuring in sea urchin embryos. The 

functional change we focus on is the dramatic increase in xenobiotic transporter activity that 

happens after fertilization. This event can be observed in live embryos requiring only non-

toxic and inexpensive dyes, a fluorescence microscope, and just a few hours to conduct the 

assay (Hamdoun et al., 2004).

This chapter outlines an undergraduate student laboratory on xenobiotic transport in sea 

urchin embryos. Because this lab addresses concepts in developmental biology, medicine, 

and environmental toxicology, the protocol is of interest to a wide range of biological or 

environmental science students. For instance, the biology of fertilization is itself a core topic 

in most developmental biology laboratories. In addition, the xenobiotic transporter activity 

that students will observe is mediated by a subset of ATP-binding cassette (ABC) 

transporters, proteins that may be familiar to pre-medical students due to their clinical role in 

drug disposition and resistance (e.g., chemotherapeutic resistance, Giacomini et al., 2010; 

Gottesman, Fojo, & Bates, 2002). Finally, this protocol introduces core concepts in 

environmental toxicology since, in addition to effluxing drugs, xenobiotic transporters also 

protect cells from man-made environmental toxicants. As such, the exercise is useful in 

illustrating the “elimination” component of ADME (Absorption, Distribution, Metabolism, 

and Elimination). Finally in pollution monitoring worldwide, sea urchins are a popular 

Shipp et al. Page 2

Methods Cell Biol. Author manuscript; available in PMC 2019 April 29.

A
uthor M

anuscript
A

uthor M
anuscript

A
uthor M

anuscript
A

uthor M
anuscript



system (see Chapter “Methods for toxicology studies in echinoderm embryos and larvae” by 

Torres-Duarte et al. of this book), and this lab presents a modified version of the fertilization 

assay used by the United States Environmental Protection Agency (EPA) (Dinnel, Link, 

Stober, Letourneau, & Roberts, 1989; U.S. Environmental Protection Agency, 2002, 2009).

The exercise presented here capitalizes on two robust assays to create a novel laboratory 

experience with unique learning opportunities. Students will first observe the efflux-

transport mechanism that protects embryos from xenobiotics. They will then measure a 

consequence of xenobiotic accumulation in gametes, by testing the effects of pollutants on 

fertilization. Finally, students will analyze and statistically evaluate their data. These 

activities introduce techniques that are ubiquitous in modern biology research, including 

conducting a fluorescence-based reporter assay, organizing electronic and tabular data, 

performing statistical tests, and using ImageJ freeware—which is now a requisite skill in 

microscopy (Schindelin, Rueden, Hiner, & Eliceiri, 2015). Upon completing the exercises, 

students will have gained experience with pollution monitoring methods, quantitative 

microscopy, and critical evaluation of data and assay design. This inquiry-driven learning 

experience provides an engaging way to teach principles of fertilization, membrane 

reorganization, transport activity, and cellular protection.

The activity is designed as a 2-day laboratory that will take 2–4 h each day, and it could 

alternatively be completed in a single longer period. Apart from this Introduction, the 

chapter is formatted such that it can be copied with little or no modification into student 

laboratory manuals. Additional notes to instructors, including catalog numbers for materials, 

are included as chapter footnotes. The entire protocol can be completed at room temperature 

with gametes and embryos of Lytechinus pictus, and it has the potential to be modified for 

use with other regional speciesa. The exercises are appropriate for upper division US 

university students—which is typically third and fourth year—but could be adapted for 

levels ranging from advanced high school to new graduate students. Most will benefit from 

having previously completed introductory (lower division) biology coursework, including at 

least one laboratory. While it is useful for students to conduct a sea urchin fertilization lab 

(Epel et al., 2004; Vacquier, 2011) prior to completing this one, it is not a requirement.

2 LABORATORY DAY 1: ACTIVATION OF TRANSPORTERS AT 

FERTILIZATION AND THE EPA TOXICITY TEST

2.1 BACKGROUND

Sea urchins provide a useful model system for studying the biological effects of toxins 

(Chapter “Methods for toxicology studies in echinoderm embryos and larvae” by Torres-

Duarte et al., this volume). Sea urchin gametes (sperm and eggs) are released into the open 

ocean where embryonic development proceed among many environmental challenges. To 

aTo allow the experiments to be conducted at room temperature, this protocol uses Lytechinus pictus. Adult animals can be obtained 
from commercial sources (see Chapter “Procuring animals and culturing of eggs and embryos” by Adams et al., this volume) and 
shipped to regions where the species is not indigenous. Strongylocentrotus purpuratus, the species in which the increase of efflux 
transport was first observed (Hamdoun et al., 2004), can also be used but requires that gametes and embryos be chilled (optimally to 
15 °C). If adapting this lab for other species, a pilot experiment is suggested to confirm that the lab will work, since the activation of 
transport is more difficult to observe in certain species, such as those with high amounts of interfering pigments in the egg.
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cope with these temperature, salinity, and chemical stressors, marine embryos have evolved 

extensive cellular protective mechanisms. In today’s industrial world however, a marine 

embryo’s environment contains many new, anthropogenic chemical stressors (xenobiotics) 

that may or may not overcome the organism’s evolved protective capabilities.

The United States Environmental Protection Agency (EPA) is a federal organization whose 

purpose is to regulate and enforce laws that protect human and environmental health. The 

EPA uses a variety of model organisms and toxicity assays to evaluate the safety of 

environmental contaminants and prioritize their regulation. To test the toxicity of effluents 

discharged into the environment, the EPA conducts a fertilization assay using sea urchin 

gametes (U.S. Environmental Protection Agency, 2002, 2009).

Sea urchins are an optimal system in which to assay fertilization because the merging of egg 

and sperm is accompanied by the appearance of a fertilization envelope (FE, Fig. 1), and the 

presence of the FE can be easily and rapidly scored under a low-power microscope. FE 

formation occurs in response to a rise in intracellular calcium levels within the egg, which is 

normally triggered by sperm-egg fusion. However, in the absence of living/healthy sperm, 

the appearance of the FE can also be aberrantly triggered by simply increasing the 

membrane’s permeability to calcium (e.g., with calcium-ionophore or a detergent), thereby 

artificially increasing intracellular calcium and leading to activation of the egg.

One mechanism embryos (and adult organisms) have evolved to protect against chemicals 

involve a group of transmembrane proteins called ATP-binding cassette (ABC) transporters 

(Fig. 2). ABC transporters use ATP to power transport of myriad substances across 

membranes (Fig. 2B), and some of these proteins specialize in the efflux of harmful 

chemicals from cells.

To monitor cellular accumulation or efflux of xenobiotics, it is necessary to have a reliable 

assay for detecting these chemicals. Assays that employ colored or fluorescent “reporter 

molecules” are especially useful, as we can detect their accumulation with a microscope. 

One such compound is Calcein-acetoxymethylester (calcein-AM, C-AM), a membrane 

permeable, non-fluorescent substrate of ABC transporters (Homolya, Hollo, Müller, 

Mechetner, & Sarkadi, 1996). Upon entering a cell (such as a sea urchin egg), C-AM is 

hydrolyzed to calcein by intracellular esterases, which causes the calcein molecule to 

fluoresce and lose its membrane permeability, thus trapping it within the cell. The only way 

the molecule can leave the cell is via transporter proteins (Fig. 3). Thus, when a cell has high 
ABC transport activity, intracellular fluorescence is low because the calcein is exported from 

the cell (Fig. 3A). When ABC transport activity is low, intracellular fluorescence is high 
because the calcein accumulates in the cell (Fig. 3B). We can measure transport activity by 

comparing fluorescence of different cells exposed to C-AM for the same period of time.

In today’s laboratory, we will use gametes and embryos of the painted white sea urchin, L. 
pictus, to monitor cellular protective mechanisms and assess toxicity of several common 

chemicals/pollutants. To monitor protective mechanisms, we will assess ABC transporter-

mediated chemical efflux activity before and after fertilization, using the calcein 

accumulation assay described above and fluorescence microscopy. We will then run a 
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modified version of the EPA toxicity test to evaluate sensitivity of marine organisms to 

several types of chemicals that humans commonly discharge into the environment (Fig. 4): 

organic solvents (acetone), detergents (household soap), and hydrocarbons (motor oil).

2.2 SPECIFIC ACTIVITIES AND LEARNING GOALS

Part A

Specific Activities:  Fertilize eggs, and incubate eggs and embryos in a xenobiotic 

transporter indicator (Calcein-AM). Examine eggs and embryos on the microscope and 

collect data using fluorescence microscopy.

Learning goals:  To practice basic laboratory skills including pipetting, calculating 

chemical dilutions, and formulating and testing a hypothesis. To collect and organize digital 

data from quantitative microscopy.

Part B

Specific Activities:  Evaluate the toxicity of acetone, soap, and motor oil on marine 

embryos by running a modified version of the EPA fertilization toxicity test.

Learning goals:  To critically evaluate the strengths and limitations of a protocol, and use 

these conclusions to optimize a protocol.

2.3 MATERIALSb

• 0.22μm filtered seawater (FSW) or artificial filtered seawater (AFSW)

• L. pictus eggs and sperm (50μL eggs in 2.5mL FSW; concentrated “dry” sperm 

on ice)

• Fertilized (0.5–1 h post-fertilization, hpf) L. pictus embryos

• Chemicals: acetone, household soap (hand/dish/laundry—avoid hand soap with 

added moisturizers), motor oil

• Calcein-AM (1mM stock in DMSO)

• Plastic transfer pipettes

• P10, P200, P1000 pipettes and tips

• 1.5-mL microcentrifuge tubes

• Centrifuge (optional but preferred—to spin down C-AM dilution)

• Permanent markers

• Disposable round-bottom glass culture tubes, 13 X 100 mm

bNotes on preparing materials: For information about making artificial seawater (if filtered seawater is unavailable), obtaining sea 
urchin gametes, and starting embryo cultures, see Chapter “Procuring animals and culturing of eggs and embryos” by Adams et al. of 
this volume. To obtain the 1mM Calcein-AM stock, a pre-made solution (1mg/mL in DMSO, 1.006 mM) can be purchased (Thermo 
Fisher C3099). Alternatively, solid Calcein-AM (Thermo Fisher C1430) can be purchased, then resuspended with fresh DMSO and 
mixed well immediately before using.
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• Microscope slides

• Compound microscopes with 10 × and 20 × objectives

• Fluorescence microscope (to be operated by instructor)

2.4. PART A: VISUALIZING EMBRYONIC PROTECTION USING A CHEMICAL EFFLUX 
ASSAY AND FLUORESCENCE MICROSCOPY

2.4.1 Procedure

1. From your instructor, obtain unfertilized eggs, 0.5–1 hpf fertilized eggs 

(embryos), and 1 mM calcein-AM (C-AM).

Eggs and embryos have been prepared in 2.5mL FSW.

Avoid getting C-AM on your hands, as it is dissolved in DMSO, which carries 
solutes across cell membranes.

2. Prepare the C-AM for 250nM treatment.

a. Calculate what volume of 1mM C-AM stock must be added to a final 

volume of 2.5mL FSW for a final concentration of 250nM C-AM: 

_________ Hint: C1V1 =C2V2

b. Do we have a pipette to transfer this volume of C-AM?

c. Make a 10 × dilution of C-AM by adding 4 μL of 1mM C-AM to 36μL 

FSW in a microcentrifuge tube. Flick the tube vigorously to mix. The 
C-AM stock solution is viscous, so be sure to mix well. Collect the 

liquid at the tube bottom using the centrifuge. What concentration is 

your new stock? _________

3. Treat the eggs and embryos with C-AM.

a. Add your 6.25μL of 0.1mM C-AM to each glass tube of eggs/embryos. 

Gently invert to mix well. Mark the time of C-AM addition in your lab 

notebook.

4. Incubate samples in C-AM for 1.5–2h on the benchtop.

5. Before continuing, formulate a hypothesis about which samples—eggs or 

embryos—will accumulate more calcein. Think about which developmental 

stage might activate stronger cellular protective mechanisms.

Write your hypothesis here, and explain your reasoning.

6. Continue to Part B while you are waiting for the incubation to finish, then return 

to measure calcein accumulation once you complete Part Bc.

cThe excitation/emission maxima for calcein are 495nm/515nm (Fig. 5). Collect only the calcein fluorescence images; do not collect 
other channels such as brightfield or DIC, because it could potentially confuse students when they do the analysis in ImageJ. It is 
likely that the eggs will be at the maximum of the dynamic range, and the embryos will be at the minimum. Imaging settings (laser/
lamp intensity, gain) should be based on egg fluorescence, as it will be much brighter than embryo fluorescence. If the dynamic range 
is too broad for the imaging setup, the concentration of calcein-am can be reduced accordingly.
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7. Continue here after 1.5–2h incubation and once Part B is completed.

8. Measure accumulation of calcein using the fluorescence microscope. (The 

instructor will operate the fluorescence microscope).

a. Prepare a slide with a drop of eggs, and bring it to your instructor.

b. Your instructor will visualize the eggs using a 10× or 20× objective and 

bright-field microscopy. When the eggs are in focus, the white light will 

be turned off, and fluorescence will be visible when calcein is excited 

with ~488nm light.

c. Your instructor will capture images of >5 fluorescing eggs.

d. Prepare a slide with a drop of embryos (their current developmental 

stage will depend on how long it has been since fertilization, Fig. 6), 

and bring it to your instructor to repeat imaging.

Make sure you obtain images of at least five eggs and five embryos.

9. The data (images) you collected will be analyzed during the next laboratory. 

Follow good practices when creating file names (e.g., 

YYYYMMDD_xenobioticlab_eggORembryo_sample#.xxx), and do not 

misplace the files.

Note: When organizing data files for an experiment, it is very important to have a 

logical and consistent file naming system. This is increasingly necessary as you 

generate larger data sets. For more suggestions on developing your own naming 

system, see: https://library.stanford.edu/research/data-management-services/data-

best-practices/best-practices-file-naming

2.4.2 Questions

1. Why is it important that C-AM is membrane permeable but calcein is not?

2. Why is it especially useful that calcein fluoresces, but C-AM does not?

3. How could we modify our experiment to measure chemical accumulation of a 

compound that is always fluorescent (whether it is inside the cell or not)?

4. Why is it necessary to compare samples that have been exposed to calcein for the 

same length of time? Hint: Within the timeframe of this experiment, calcein 
accumulates linearly with time.

5. Does it seem like all the eggs or embryos within your samples are equally 

fluorescent? What could account for any variation you see?

6. What would happen to ABC-transporter activity if a chemical depleted the cell’s 

ATP? Now, ignoring the ABC-transporters in the cell, what else do you think 

would happen to the cell if its ATP were depleted?
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2.5 PART B: THE SEA URCHIN FERTILIZATION EPA TOXICITY TEST

2.5.1 Procedure—Note: the actual EPA test involves soaking sperm in the test solution 

for 20min, then adding eggs, waiting 20 more minutes, and finally counting >100 eggs to 

evaluate fertilization. We will be soaking both the sperm and eggs in the test solution for 

only 10min, then we will mix them and wait another 10min before counting 20 eggs to 

evaluate fertilization.

1. Obtain eggs, sperm, FSW, acetone, hand/dish/laundry soap, and motor oil.

2. Prepare four solutions—Control (FSW only), Acetone, Soap, and Oil—in two 

glass culture tubes each (eight tubes total).

a. Label one tube “Control eggs” and another “Control sperm,” and fill 

them each with 3mL FSW.

b. Label one tube “Acetone eggs” and another “Acetone sperm,” and fill 

them each with 3mL FSW+ 30 μL acetone. Flick to mix.

c. Label one tube “Soap eggs” and another “Soap sperm,” and fill them 

each with 3mL FSW+ 5μL soap. Flick to mix.

d. Label one tube “Oil eggs” and another “Oil sperm,” and fill them each 

with 3mL FSW+ 5μL oil. Flick to mix.

3. Add gametes to each test solution. Mark the time of addition in your lab 

notebook.

a. To each “eggs” test solution, add 50μL settled eggs. Flick the tubes to 

mix thoroughly.

b. To each “sperm” test solution, add 3μL sperm. Sperm is viscous, so 

pipette very slowly to allow the sperm to travel through the pipette tip. 

Flick the tubes to mix thoroughly.

4. Wait 10min, then fertilize the eggs. First flick the sperm solution tube to mix, 

then add 100μL to the appropriate tube of eggs.

a. Add 100μL “Control sperm” solution to the “Control eggs” tube, and 

mix by flicking. Record the time of sperm addition in your notebook.

b. Mix the Acetone eggs and sperm similarly, and record the time of 

sperm addition in your notebook.

c. Mix the Soap eggs and sperm similarly, and record the time of sperm 

addition in your notebook.

d. Mix the Oil eggs and spermsimilarly, and record the time of sperm 

addition in your notebook.

5. Wait 10 min, then determine the percent of fertilized eggs in each test solution by 

counting how many eggs do and do not have a FE under the microscope. Begin 

with the controls (FSW only), which should have at least 70% fertilization.
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a. Prepare a microscope slide with eggs. Flick the tube to resuspend the 

eggs in the water and use a plastic transfer pipette to transfer one drop 

onto the slide.

b. Use the 20×objective on your microscope to visualize the eggs in the 

droplet. Take care not to plunge the objective into the droplet while you 

are focusing the microscope. We are not using coverslips, so this is 

important as seawater can ruin an objective!

c. Count the first 20 eggs you see and record in your notebook how many 

of them are fertilized (i.e., have a clear fertilization envelope, FE; refer 

to Fig. 1).

6. Answer the following questions before continuing:

a. By measuring the presence of the FE, what could we be measuring 

other than just fertilization? Hint: refer to the background information 
for this lab.

b. How could we modify the protocol to ensure we are observing just 

fertilization? Come up with a quick experiment and try it for each of the 

chemicals that produced “fertilization” before returning to Part Ad. 

Record your experimental design and results in your lab notebook.

7. Return to Part A to measure calcein accumulation in the eggs/embryos. Continue 

here when you complete Part A.

8. Compare the egg fertilization percentages in your acetone, soap, and oil solutions 

to the control solution.

a. Draw a bar graph of the fertilization percentages. Plot “% fertilized” on 

the y-axis, and your various treatments (control, acetone, soap, and oil) 

on the x-axis.

2.5.2 Questions

1. How do the fertilization percentages change in response to acetone, soap, and 

motor oil?

2. What conclusions can you draw about the toxicity of each chemical to sea urchin 

gametes?

3. 3. Do you think an activated egg (as opposed to a fertilized egg) will develop into 

a healthy sea urchin? Discuss the genetic basis of your reasoning. Hint: Think 
about ploidy.

4. Do you think the EPA fertilization test is an appropriate way to measure toxicity? 

Why or why not?

dStudents will hopefully propose that they expose eggs to acetone, soap, and oil, then evaluate them without adding sperm. This will 
resolve whether the FE is the result of fertilization or activation. Anticipated results: 30μL acetone will fertilize (but they will look 
unhealthy), 5μL soap will activate not fertilize, and 5μL motor oil will neither activate nor fertilize.
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3 LABORATORY DAY 2: ANALYZING AND PRESENTING SCIENTIFIC DATA

3.1 BACKGROUND

In the previous laboratory, we performed a calcein accumulation assay with unfertilized eggs 

and embryos to assess ABC transporter-mediated efflux activity. We then performed a 

modified version of the EPA toxicity test, using fertilization of sea urchin eggs as an 

endpoint, to assess toxicity of acetone, soap, and motor oil.

Today, we will analyze the data collected in the previous lab using ImageJ freeware made 

available by the National Institutes of Health (NIH). We will quantify the calcein 

fluorescence in unfertilized eggs and 2–8 cell embryos, then compare the ABC transporter 

efflux activity of eggs and embryos based on our data. We will use Microsoft Excel to plot 

data from both the calcein assay and the modified EPA assay, and we will perform basic 

descriptive statistics with the calcein assay data to determine if our findings are significant.

3.2 SPECIFIC ACTIVITIES AND LEARNING GOALS

Specific Activities: Collect data from fluorescence microscope images, graph quantitative 

fluorescence data, and perform descriptive statistics.

Learning Goals: To learn techniques and practices for quantitative image analysis and 

gain an introduction to common types of scientific software including ImageJ and Excel. To 

test hypotheses generated on Day 1.

3.3 MATERIALS

• Calcein fluorescence images collected during the previous lab

• Computer

• ImageJ64 freeware

• Data collected during previous lab

• Microsoft Excel (or comparable freeware)

3.4 USING IMAGEJ TO ANALYZE EFFLUX ACTIVITY DATA COLLECTED ON DAY 1

3.4.1 Procedure

1. Download ImageJ onto your computer by following the instructions at: https://

imagej.nih.gov/ij/download.html

a. For more information on ImageJ, a general tutorial can be found here: 

https://imagej.nih.gov/ij/docs/guide/user-guide.pdf. However, the below 

instructions should be sufficient for completing today’s analyses.

2. Open the calcein image files collected during the previous laboratory in ImageJ.

a. If the image opens and you cannot see the eggs/embryos, click on your 

image, then go to Image> Adjust> Brightness/Contrast. A window 

will appear where you can adjust brightness/contrast (Fig. 7A). If the 

eggs/ embryos are too dim to see, it is important to increase the 
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brightness enough that you can see the outline of the cells (Fig. 7B). 

Adjusting the brightness here will not affect your fluorescence 

measurements (the program retains the original numerical brightness 

data regardless of how you visually manipulate the image here).

3. Quantify the calcein fluorescence of five eggs and five embryos. Begin with the 

eggs.

a. Locate the toolbar, and use either the oval tool (Fig. 8A) or the 

freehand tool (Fig. 8B) to draw around the outline of your egg (Fig. 

8C).

i. If you use the oval tool, you can hold down shift as you are 

drawing to make it a circle. Once you have drawn the circle, 

you can click in the center of your circle and drag it if it needs 

to be moved slightly. You can also adjust the size/dimensions 

by dragging the small white boxes distributed along the yellow 

outline.

ii. If you use the freehand tool, you cannot move the shape once 

it has been drawn.

b. Measure the fluorescence inside the outline you drew, called the Region 

Of Interest (ROI), by clicking on Analyze> Measure. A “Results” 

window will appear, listing the Area of your ROI, the Mean 

fluorescence of your ROI, and the Minimum and Maximum 

fluorescence of your ROI (Fig. 8D).

c. Draw an outline of your next egg, repeating the same process as 

described above, and again go to Analyze> Measure. A new row will 

be created with the data from this second ROI. If you need to open a 

new image to locate another egg, this is not a problem; each 

measurement is added as a new line regardless of which image file it 

came from.

d. Repeat this procedure until you have five eggs measured.

e. After you measure five eggs and have five rows of data, click on the 

“Results” window, then go to File> Save As, name the file 

“YYYYMMDD_ xenobioticlab_egg_results”, and save your data as a, 

type.xls file.

f. Repeat the measurements with your embryo samples. If they are 2-cell 

stage or older, you will need to use the freehand tool (Fig. 8B) to 

outline the embryos (Fig. 8E).

g. After you measure five embryos, save your results as 

“YYYYMMDD_xenobioticlab_embryo_results.xls”, as you did for the 

egg data.
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4. Graph your calcein fluorescence values as a bar graph in Microsoft Excel, 

OpenOffice, or comparable software.

These instructions were written for use with Microsoft Excel. Options and 

formulas may be slightly different depending on which version of Excel (Mac, 

PC, year) is used. The procedure to graph data should be similar in other 

programs, and in most cases a simple Google search can resolve any 

discrepancies.

a. In Excel, open your results files 

(“YYYYMMDD_xenobioticlab_egg_results.xls” and 

“YYYYMMDD_xenobioticlab_embryo_results.xls”).

b. Combine all the data into one document: copy data from each set of 

results and paste it into a new Excel document. Label the two groups of 

results “Egg” and “Embryo.” Name this new document appropriately 

using your consistent file naming system.

c. We will work only with the mean fluorescence values (which should 

be in column C) and will ignore the Area, Min, and Max values.

d. For each group of data points (egg and embryo), take your five mean 

fluorescence values and calculate the average. To do this, click on the 

cell below the fifth mean fluorescence value. Type “=average(“, then 

use the mouse to highlight all five mean fluorescence values, type “)”, 

and hit Enter/Return on your keyboard. The program will calculate the 

average of the five values you selected.

e. Now calculate the standard deviation for each average. Click on the 

cell below the one containing the average calculation. Type “=stdev(“, 

then use the mouse to highlight all five mean fluorescence values, type 

“)”, and hit Enter/Return on your keyboard. The program will 

calculate the standard deviation of the five values you selected around 

the average.

f. In the cells to the left of your calculated average and standard deviation 

values, label them “Egg average fluorescence,” “Egg standard 

deviation,” “Embryo average fluorescence,” and “Embryo standard 

deviation.” You will plot the Egg average fluorescence and Embryo 

average fluorescence in a bar graph, and you will represent each 

group’s standard deviation with error bars.

g. In a blank area of the spreadsheet, rearrange your calculated values so 

they are in the order shown in Fig. 9. Do not simply copy and paste, 

because the program will paste the formula rather than the numbers. 

Instead, to paste the average and standard deviation values, use Edit> 
Paste Special. Under “Paste”, select Values. Under “Operation”, select 

None. Click OK.
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h. Create a bar graph of your average fluorescence values. Highlight the 

four cells shown in dark gray (Fig. 9; Egg, ###, Embryo, ###). In the 

menu, click on Charts, then Column, and under 2-D column, click 

Clustered Column. Labels will automatically be added to the x-axis. 

Delete the legend, as it is unnecessary.

i. Create error bars representing the standard deviation around each 

average. In the graph, double click on the egg bar. A “Format Data 

Series” window will open. On the left panel of this window, click Error 
Bars. Under “Display,” click Both. Under “End style,” click Cap. 

Under “Error amount,” click Custom, then click Specify Value. A 

“Custom Error Bars” window will open. In the “Positive Error Value” 

space, highlight and delete anything in the space, then highlight the two 

standard deviation values shown in light gray (Fig. 9). This will create 

positive error bars the length of your calculated standard deviation 

values. Repeat the same process in the “Negative Error Value” space. 

Click OK. Click OK again.

j. Complete your graph with axis labels and a figure legend. Label the 

appropriate axis “Mean fluorescence (arbitrary units)” and the other 

axis “Developmental stage of L. pictus.” Print this graph to include in 

your lab notebook and write a descriptive figure legende

5. To test whether the difference in calcein accumulation you measured in eggs 

versus embryos is significant, perform a statistical analysis using a two-tailed 

unpaired Student’s t-testf. We use the Student’s t-test because it is the most 

commonly used technique for testing whether two datasets are different based on 

the difference in means between two samples.

a. On the same Excel worksheet containing your egg and embryo 

fluorescence data, in an empty cell, type “=ttest(“, then use the mouse 

to highlight all five mean egg fluorescence values, type “,”, then use the 

mouse to highlight all five mean embryo fluorescence values, type “,” , 

type “2,”, type “2)”. Press Enter/Return.

b. The cell you typed in will now display the P-value for the t-test. Record 

your P-value in your lab notebook. You may also write it on the graph 

you generated in Step 4 and/or include it in your descriptive figure 

legend. Typically, a P-value of <0.05 is considered “statistically 

significant.” This is because the P-value denotes the probability of 

obtaining results as or more extreme than the observed results, 

assuming there is no difference between the two conditions (e.g., P 
=0.05 means 5% probability). Therefore, the smaller the P-value, the 

eAnticipated results: eggs will accumulate significantly more calcein than embryos, indicating that ABC transport activity is higher in 
embryos than unfertilized eggs.
fDepending on the version of Microsoft Excel used by the students, it may be necessary to provide alternative instructions to perform 
the analysis. Here are instructions to install and use StatPlus, which will enable descriptive statistics for Excel for Mac 2011 
users:After you have entered all the data into Excel, Download StatPlus from: http://www.analystsoft.com/en/products/statplusmacle/
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less likely it is that as or more extreme results could be obtained, and so 

with a P-value below our pre-determined threshold of 0.05, we reject 

the hypothesis that there is no difference between the two conditions, 

and accept the hypothesis that the difference is statistically significant.

c. For a more in-depth overview of the t-test, see below link: http://

www.chem.utoronto.ca/coursenotes/analsci/stats/ttest.html

6. Now that you have some familiarity with generating bar graphs in Excel, transfer 

your data from the modified EPA toxicity test into an Excel spreadsheet, and 

create a bar graph (you will not have error bars on this graph). Write a 

descriptive figure legend.

3.4.2 Questions

1. Which had higher calcein accumulation: eggs or embryos?

2. What does this tell us about the relative ABC transporter efflux activity in eggs 

compared to embryos?

3. Do you think eggs or embryos are more “protected” from chemicals in the 

environment? Explain how your experimental results led you to draw this 

conclusion.

4. If you were to perform the EPA toxicity test from the previous lab—but this time 

you fertilized the eggs first, waited 1h, then exposed them to the test chemicals—

do you think the embryos would be more or less affected by the chemicals? 

Why?
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FIG. 1. 
Lytechinus pictus eggs before (A) and after (B) sperm fusion. Fertilization is marked by the 

appearance of the fertilization envelope in (B). Eggs are 120μm in diameter.
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FIG. 2. 
ABC transporters are found in the membranes of all known organisms. Members of this 

large family of proteins all use power released by the hydrolysis of ATP to transport 

substrates, often against their concentration gradients. Individual ABC transporters differ in 

the substrates they transport; some translocate lipids, others move ions, and still others 

transport signaling molecules. The subset of ABC transporters called Multidrug resistance 

(MDR) transporters can efflux xenobiotics from cells. They earned the “MDR” name 

because of their ability to keep chemotherapeutic drugs out of cancer cells, leading to 

multidrug resistance. (A) A schematic of a cell expressing an ABC transporter localized to 

the plasma membrane. (B, inset) ABC transporters use energy from ATP to efflux a variety 

of xenobiotics from the cytoplasm to the extracellular space.
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FIG. 3. 
A schematic showing the expected results of the calcein-AM assay under conditions of high 

(A) and low (B) ABC transporter activity.
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FIG. 4. 
Structures of acetone, detergent (soap), and hydrocarbons (motor oil). The unique molecular 

features of these chemicals render them toxic to living cells. Acetone in high quantities will 

dissolve cell membranes, altering their permeability to ions and other molecules and 

disrupting the cell’s protective barrier. Additionally, due to its small size, acetone can enter 

the cytoplasm of the cell and interfere with enzymes that regulate cell metabolism. 

Detergents are water-soluble salts of fatty acids that are highly effective at permeating and 

disrupting cell membranes due to their ability to form micelles, which are single, spherical 

layers of detergent molecules that can surround membrane lipids in an aqueous environment. 

Hydrocarbons lack the charged head of a detergent and therefore cannot form micelles, but 

they can still enter the lipid bilayer and interfere with the function of proteins and lipids in 

the cell membrane.
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FIG. 5. 
The absorption and emission spectra of calcein.
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FIG. 6. 
Development of sea urchin embryos over time. Micrographs show the progressive cell 

divisions that occur from 1.5 to 3h post-fertilization (hpf) when embryos are grown at room 

temperature (22°C). Development will proceed faster if room temperature is higher and 

slower if room temperature is lower.
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FIG. 7. 
How to adjust image brightness in ImageJ. (A) The Brightness/Contrast control panel. (B) A 

calcein-exposed egg and embryo of sufficient brightness to see and outline.
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FIG. 8. 
How to outline eggs and embryos to measure fluorescence in ImageJ. (A) The location of 

the Oval tool. (B) The location of the Freehand tool. (C) A calcein-exposed egg outlined for 

analysis using the Oval tool. (D) The Mean column in the Results panel shows calcein 

fluorescence measurements of five different samples. (E) A calcein-exposed embryo 

outlined for analysis using the Freehand tool.
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FIG. 9. 
How to arrange calculated values in Excel to generate a bar graph with error bars.
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